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Introduction
WinPass is a small and efficient user friendly Windows application designed to help
you memorize and manage your passwords. Today every PC user is managing
accounts in a handful of Internet websites, ranging from email accounts to bank
accounts, social security and health accounts and many more.

Every website has its own policy on handling security. Some require more then just
user name & password, other imply strict policy on how to create your password,
others require that you change your password every now and then.

All those demands make it very difficult for the day to day user to memorize and
manage his valuable passwords.

Using WinPass you can store all your passwords and complementary data in a single
database protected with one Master Password, so that you have to memorize only
one password. The database is encrypted using the best and most secured
encryption algorithms known today (SHA1 and TwoFish).

Using WinPass
WinPass is a Tray Icon application. 
When you need to login to a website do the following:

� Click the WinPass Icon.
� Double Click the website of interest.
� Wait for the website to open and display the login form.
� Double Click the first input box (usually titled Username) .

WinPass Highlights
� WinPass - is easy to install and use.
� WinPass - is using SHA1 and TwoFish crypto algorithms for the highest

protection of your sensitive data.
� WinPass - is compatible with any browser and any PC application.
� WinPass - is a small application that runs from your PC tray, no need to install

yet another toolbar in your browser.
� WinPass - can be easily installed and operated from your DiskOnKey, so you

can carry your protected passwords with you and use them every where.
� WinPass - will automatically minimize itself to the tray after a short (user

defined) period of time so that no one can peep at your sensitive data.
� WinPass - include a built in synchronization wizard. Use this wizard to

synchronize your databases if you are using WinPass on two or more PCs.
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Installation
WinPass is distributed as a single installation file "WinPassSetup.exe".
Download the file from the internet to your PC.
Double Click the file and follow the instruction of the installation wizard.
The setup program will add WinPass shortcuts to your desktop and to the quick
launch bar.
At the end of the setup process WinPass will run for the first time and display the
following dialog:

Click the [Create New Data File] button. Navigate to the place where you want to store
your file, give it a meaningful name and click [Save].
WinPass will display the "New Password" dialog:

This is your Master Password. Enter a password that is secured and make sure you
remember it for later use. WinPass will prompt you to enter the password twice to
make sure you made no mistakes when entering the password. 
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The minimum length of a password is 6 characters. We recommend that you enter a
longer password and that your password will include a mix of upper and lower case
characters as well as numbers and special characters (~!@#$%^&*).

After entering the password, WinPass will open in the bottom-right corner of your
screen, as seen in the following image:
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Handling Groups
WinPass can help you organize your password entries in groups. The following
groups are available by default: WebSite, Internet, Email, Personal, Applications,
Miscellaneous. Use the Group selection box to select the active group.

 

The following operation are available form the "Group" menu:

Add a New Group
From the "Group" menu, select "New Group...". WinPass will prompt you to enter the
new group name. Enter a new group name and click [OK].

Delete Group
From the "Group" menu, select "Delete Group...". WinPass will display a warning
message indicating that this operation can not be undone, and all the data in the group
will be lost. Click [Yes] to complete the operation.

Rename a Group
From the "Group" menu, select "Rename Group...". WinPass will prompt you to enter
a new name for the group. Enter a new name and click [OK].
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Handling Data Entries
The following operations are available form the "Entry" menu:

Learn New Entry
Use the "Learn New Entry" option while you are using the browser to login to a service.
Use the following procedure (sample):

� Open your browser and navigate to the login page of your favorite webmail
service (Gmail, Yahoo, Hotmail, etc...).

� On WinPass dialog click the  button to open the "Learn New
Entry" dialog.

� In the browser enter the Username and Password (You must enter both even if
the browser already remember part of the information).

� Hit the [Enter] key on the keyboard to submit the information.
� WinPass will popup a confirmation message box.
� Click [Yes].
� The "Learn New Entry" dialog will close and the name of the service will appear

on the WinPass list.

Repeat this procedure to add more entries.
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Add New Entry
From the "Entry" Menu select "New Entry...". 
WinPass will display the "New Entry" dialog:

Enter a meaningful name in the "Entry Name" field.

In the "URL/EXE" field enter the URL of the login webpage of the relevant website. If
your browser is currently opened and the login page is displayed, click the [Get URL]
button to copy the URL from the browser.

WinPass is not limited to work with browsers only. WinPass can work with any PC
application that requires password login. Click the [Get EXE] button to locate the
executable file (*.exe) or batch file (*.bat) or pif file (*.pif) that starts the PC application.

After you defined the "Entry Name" and "URL/EXE" fields you can start entering the
rest of the data. Data must be entered in the order it is expected in the login page.
Normally you will enter in field #1 the username and in filed #2 the password as shown
in the next image:

You may enter more then 2 fields. WinPass can accept up to 15 fields for every entry.
When you conclude entering the data click [OK] to store the entry in the database.
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Updating Entry
Highlight the entry you want to update. From the "Entry" Menu select "Update Entry...".
WinPass will display the "Update Entry" dialog, which is similar to the "New Entry"
dialog.

Use this dialog to modify any item of the entry including "Entry Name" and URL. You
can also change the order of the fields using the [Up] and [Down] buttons.

Delete Entry
Highlight the entry you want to delete. From the "Entry" Menu select "Delete Entry...".
WinPass will display a message box asking you to confirm the operation. Click [Yes]
to delete the entry.

Rename Entry
Highlight the entry you want to rename. From the "Entry" Menu select "Rename
Entry...". WinPass will display the "Rename Entry" dialog:

Type a new name and click [OK].
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Move Entry
You can move an entry from one group to another. Highlight the entry you want to
move. In the "Entry" Menu select "Move Entry" and then select the group you want to
move the entry to.

WinPass will display a message box asking you to confirm the operation. Click [yes]
and WinPass will move the entry to the selected group.

Please Note
All Entry related operations described so far are accessible also from a context menu
that you can popup by right clicking the entries list.
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Using WinPass to launch a website
After you have created your database of password entries you can start using it.
Let us use the GMAIL entry as a sample:

   

As can be seen in the above images, the GMAIL sample points to the login page of
GMAIL. 
Make sure the "Update Entry" dialog is closed.

Now "Double Click" the GMAIL line in the WinPass list or "Click" the  icon.
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The login page of GMAIL will open and display the following screen: 

Move the mouse pointer to the "Username" input box.
Double Click the left mouse button.
WinPass will fill the Username and Password input boxes and "click" automatically the

 button to complete the login process.
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Login to a Website with multiple form login system
Some websites split the login process to two or more forms. 
Normally you perform the following sequence when logging into such a site:

� Open the welcome login form.
� Enter the first data item (Username or LoginID).
� Click [Submit]
� The website takes you to another form and prompts for the second data item

(Password).
� Enter the second data item
� Click [Submit].

To use WinPass with such a site do the following:
� When creating the entry of this site 

� Enter the Username in line #1.
� Leave line #2 empty.
� Enter the Password in line #3.

� Open the site by double clicking the entry name on the WinPass list.
� Double Click the Username input box.
� Wait for the site to change form.
� Double Click the Password input box to conclude the login process.
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Handling the Database File
The "File" menu offers several options to manage the database file.

New Data File...
Select this option to create a new database file.
WinPass will prompt you for a name and location for the new file.
After you select a name and location, WinPass will prompt you for a Master password
for the new file:

You must enter the new password twice to confirm that you entered it correctly.

Open Data File...
Use this menu option to open another existing data file.
WinPass will prompt you for the name and location of the new file.
After you select the new file, WinPass will prompt you for the files password. Here you
will enter the password only once.

Save Data File As...
Use this option to save a copy of your current data file under a new name and/or
location.The new file will become your default database file.
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Backup Data File...
Your WinPass database file is a precious asset.
To protect it from accidental loss you must back it up regularly.
Use this option to copy the file to another media (DiskOnKey, remote file server,
another PC, etc...).

Set New Password...
To increase the security of your WinPass database it is important that you modify your
Master password from time to time.

From the "File" menu select "Set New Password..."
WinPass will display the following dialog:

Enter the current password, and then enter the new password twice to confirm that you
entered it correctly.

Generate Password
WinPass provide a special dialog that will help you create quality random passwords.

Using this dialog you can specify the length of the password and the type of
characters that will be included in the password.
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You can call this dialog from the following places:
� From the "Files" menu.
� From the "Tray Icon" context menu.
� From the "Update Entry Dialog", by clicking the ellipsis  button in the active

field.

Print...
Select this option to print a hardcopy of your list of passwords.
For added security WinPass will prompt you once again for your Master password.

Export
WinPass can export your database to to type of file "Ascii Text File" and "CSV File"
(Comma Separated Variables).
The text file can be opened using a text editor like "Notepad".
The CSV file can be opened using a spreadsheet program like "Excel".
For added security WinPass will prompt you once again for your Master password.
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Options...
Use the options dialog to control various parameters of WinPass.

General
Use this tab to control some general aspects of the behavior of WinPass.

Stay On Top
Check this option to make sure that WinPass is always visible on top of any other
running application.

Start WinPass on Windows StartUp
If you check this option WinPass will be added to the Startup list of Windows, and
will start automatically every time you boot your PC.

Start Minimized
If you check the option "Start WinPass on Windows StartUp" it is recommended
that you check this option also. This way you will have to enter your Master
password only when you intent to use WinPass, other wise you will be prompted
for the Master password every time you boot your PC.
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Minimize to Tray
WinPass is a "Tray Application". When you start it, it will add its icon to the tray and
you can click this icon every time you want to use WinPass.

Using this option you can instruct WinPass to close its screen after a set time of
inactivity.

To restore WinPass from its minimized state just click its icon with the mouse.

Query Password on Restore
For security reasons WinPass is programmed in such a way that when it is
commanded to restore from the tray it will prompt for the Master password.

Using this option you can instruct WinPass to prompt for the password only after it
was in minimized state longer then a set time.
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Entering Credentials
Use this tab to control some aspects of WinPass behavior when entering credentials
into web forms or any other secured application forms.

Add ENTER Automatically after Double Click
If this option is checked WinPass will also click the Login of Submit button
automatically after it fills the credentials fields.

Entry is Active For
An entry becomes active when you click its name on the main WinPass list. A solid
blue or red diamond to left of the name indicates that it is active.

After a set time of inactivity the entry becomes inactive, indicated by the solid
diamond changing shape to a pale diamond.

When an entry is not active the double click option is disabled.
To reactivate an entry you must click its name once again.
Use this option to set the time an entry will remain in active state.

Enter Credentials Using
Select the mechanism WinPass will use to insert the data into to form.

Beep is ON
When this switch is ON, WinPass will beep when entering credentials.
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Going Mobile
If you work simultaneously with several computers, we suggest that you install
WinPass on your DiskOnKey. This way you will have one database accessible from
the several computers.

Make sure your DiskOnKey is attached to your PC.
Run the "WinPassSetup.exe" setup program and when the setup destination dialog
appear, navigate to your DiskOnKey drive.

When setup is complete the setup program will place the shortcut on your desktop
and now you can run WinPass directly from the DiskOnKey.

Using the "File" menu save your database file in the DiskOnKey (preferably in the
same directory where WinPass is installed).

When you move to another PC attach your DiskOnKey to the new PC and create a
shortcut to the file WinPass.exe located in the DiskOnKey. You will also have to tell
WinPass to refer to the database file located in the DiskOnKey using the "Open Data
File..." menu.

WinPass stores the setup data in the registry of every individual PC so that you have
to perform each of the actions described above only once.

Installation Wizard
WinPass include a built in "Installation Wizard". If you have already installed WinPass
on your PC, you can use this wizard to easily install a second copy of WinPass on
your DiskOnKey or any other media.

Subject to instruction you will provide during the installation process, the wizard will
perform the following:

� Install a stand alone copy of WinPass on the target media.
� Copy the existing database to the target media.
� Place another shortcut on your desktop and/or quick launch bar.
� Add WinPass to the "Auto Play" list on the DiskOnKey.

You can also use this option to install WinPass from your DiskOnKey to another PC
local drive.
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Synchronization Wizard
If you are using WinPass regularly on several PCs, you will need to synchronize the
databases every now and then.

From the "Files" menu select "Synchronize...". 
WinPass will display the Synchronization Wizard.

Synchronization will take place between the currently active database (Primary
database) and another database you will select (Secondary database).

You can decide if to synchronize "All Entries" or "Only Entries that exists in both
databases" (Entries that have the same "Entry Name" and the same "Group Name").

You can decide if you want to update both databases or just one of them.
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Registering WinPass
When you first install WinPass it starts as a DEMO. The DEMO is limited to 5 entries
of data and one Group. You can use the DEMO with this limitation for any period of
time. If you need more that 5 entries you will have to upgrade to the FULL version.

The upgrade cost is indicated on WinPass webpage:
www.pantaray.com/winpass.html

To upgrade your copy select "WinPass Registration..." from the "Help" menu.
WinPass will display the following screen:

Click the [Order Registration Code] button.
WinPass will open your browser and take you to WinPass webpage.

Click the  button to complete the payment.

When your payment is processed we will send you an email with your registration
code.

Once you receive your registration code enter it into the "Enter Registration Code"
input box and click the [Register] button.
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Advanced Topics

Field Attributes
When editing an entry you can set an attribute to each field.
The following attributes are available:

� Regular
� Password
� Note

To change an attribute Right Click the blue area to the left of the active filed, and
select a new attribute from the context menu.

A field marked as "Password" will always be displayed with Asterisk characters.
A field marked as "Note" will not be sent to the browser.

If you want to modify the attribute of a field from "Password" to "Regular" or "Note"
and the field already has some content, WinPass will request you to enter the "Master
Password".

Line #2 is marked by default as "Password".

You can perform the same action by clicking the ellipsis  button at the end of the text
box and selecting "Attributes".
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Browser
By default WinPass will always use the default browser when opening a webpages.
However you can request to open a certain webpage with a specific browser:

The following browsers are supported: 
� Explorer
� Firefox
� Chrome
� Opera

Generating a Password
When you edit a field you can click the ellipsis  button at the end of the text box. 
A menu will popup. 
Select from this menu "Generate Password...".
The "Generate Password" dialog will open and you can generate a password.
When you click OK the new password will be inserted to the field and the attribute of
the field will be set to "Password".
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Macros
When you edit a field you can click the ellipsis  button at the end of the text box. 
A menu will popup. 
Select from this menu the "Macros" option.
Select any of the following Macros:

The selected Macro will be inserted into the field.


